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Resumen

En el presente texto se detalla una propuesta de experiencias
significativas desarrolladas por estudiantes de servicio
social de los Laboratorios de Materia Condensada Blanda y
Medios Granulares de la Facultad de Fisica de la Universidad
Veracruzana. Se construye un sistema de monitoreo de cambios
de temperatura basados en una tarjeta Arduino, util para
los objetivos de ensefanza-aprendizaje bajo condiciones de
aislamiento, regularizaciéon y uatil también en los procesos de
inclusién. En la metodologia del aprendizaje por competencias
de la Universidad Veracruzana, se requiere adquirir habilidades
practicas, como podria ser electrénica, programaciéon o en el
manejo y construccion de dispositivos de adquisicién de datos
para el estudio de los fenédmenos fisicos que nos rodean. No sélo
para aprender a usarlos, sino buscar una aplicacidén que detone
su creatividad y nos ayude en la formacién y desarrollo tanto
individual como colectivo.

Lo anterior podria ser de interés por ejemplo para profesores de

secundaria o hasta los primeros semestres de la licenciatura, sobre
todo si no se han llevado talleres durante la pandemia, asi que
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puede funcionar como programa de regularizacién o nivelacién,
tanto de estudiantes que no pudieron trabajar en un laboratorio
como de escuelas que nunca han contado con un laboratorio, asi
como también para padres interesados en el autoaprendizaje, la
autonomia y la formacién integral de sus propios hijos.

Palabras Clave: Cambios de temperatura, educacién,
competencias.

Abastract

This text details a proposal of significant experiences developed
by social service students in the Soft Condensed Matter and
Granular Media Laboratories of the Physics Faculty at the
Veracruzana University. A temperature change monitoring system
based on an Arduino board was built, useful for teaching and
learning objectives under conditions of isolation and regulation,
and also helpful in inclusion processes. The Veracruzana
University’s competency-based learning methodology requires
the acquisition of practical skills, such as electronics, programming,
or the handling and construction of data acquisition devices for
studying the physical phenomena that surround us. The goal
is not only to learn how to use these devices, but also to find
an application that sparks creativity and contributes to both
individual and collective training and development.

The above could be of interest, for example, to high school
teachers or even those in the first semesters of undergraduate
studies, especially if workshops have not been held during the
pandemic. It can function as a regularization or leveling program
for students who were unable to work in a laboratory, as well as
for schools that have never had a laboratory, and also for parents
interested in self-learning, autonomy, and the comprehensive
development of their own children.

Keywords: Temperature changes, education, skills.
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Introduccién

Una de las propuestas educativas que ha tenido un auge relativo a
partir de la pandemia, es el aprendizaje basado en la investigacién
o en el desarrollo de proyectos que generen experiencias
significativas y que, con el tiempo, se vuelvan mas complejos.
Durante el periodo de pandemia, tuvimos el problema de llevar a
nuestras casas actividades que nos ayudaran a salvar la situacién
hasta cierto punto. No siempre se podian realizar actividades
practicas, que cominmente se adquieren en el desarrollo de
un proyecto o una investigacién cientifica, como en un taller de
electrénica o Arduino o en un laboratorio.

Ahora y desde que empezamos a trabajar presencialmente,
nos damos cuenta de que hace falta tiempo para regularizar y
eso requiere del apoyo de la comunidad académica, si, pero
también de la iniciativa de los estudiantes y padres o tutores,
comprometidos y conscientes de su realidad y de nuestro propio
futuro. Asi también, como el de crear o trabajar en actividades
de importancia local, para el desarrollo individual y colectivo, de
las regiones. En todo ello los laboratorios portables han ayudado
a disminuir los costos, facilitar el transporte y el desarrollo de
proyectos caseros que motiven a los estudiantes a esforzarse y
comprometerse con la comunidad. Por dar un ejemplo, en este
capitulo proponemos el estudio de diferentes fenémenos fisicos
que ocurren a nuestro alrededor, particularmente en la cocina de
nuestras casas, la cual sustituye de alguna manera un laboratorio
y es facil de usar bajo las medidas de precaucién y cuidados de
cualquier adulto responsable, como es el caso de los estudiantes
de la licenciatura que realizan su servicio social.

Otros elementos que son posibles de estudiar y de analizar sus
datos son los cambios de temperatura en una plancha cuando
esta calentado, o la temperatura de un refrigerador comparada
con la temperatura de un recipiente lleno de agua, por ejemplo,
otra pregunta legitima es la de como cambia la temperatura
de una cafetera eléctrica. Como ejemplo, de la bisqueda de
respuestas a estas interrogantes, dentro del seno de cualquier
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familia podria ser de interés investigarlo por mano propia, y con
ello adquirir conocimientos y habilidades, buscando nuestras
propias explicaciones como el hecho de que el agua dentro del
refrigerador formara cristales de hielo, o bien de que el agua se
evaporara en la cafetera y un sinfin de detalles alrededor de esos
temas como el de la solubilidad de |a sal o el azicar, la formacién
de cristales con la evaporacion entre muchos otros. Para ello se
planeé medir cdémo cambia la temperatura durante algunos de
los procesos mencionados, para identificar los cambios fisicos
cuando ocurren los fenémenos mencionados y establecer las
causas y sus efectos. En breve se mencionaran algunos ejemplos,
mediante el uso de una sonda de bajo costo usada para medir la
temperatura.

Para estudiar los fenémenos fisicos que ocurren en nuestras
casas usando dichos aparatos electrodomésticos serd
necesario obtener un termdémetro para registrar los cambios de
temperatura que ocurren durante los procesos mencionados. En
nuestro caso optamos por construir un sistema de adquisicién
de datos de bajo costo lo cual conforma la Actividad 1 de
nuestro capitulo. Después, se haran diferentes estudios, como
retos que culminaran con el aprendizaje de conceptos tedricos,
el dominio de diferentes actividades practicas, conformando las
competencias, considerando una actitud y el rol del aprendiz
que debera asumir la actitud de un investigador, para el logro
especifico de la competencia.

Actividad 1. Desarrollo de un sistema de adquisicién de datos
para estudiar los cambios de temperatura

Primeramente, para el recipiente en el cual hariamos las pruebas
con diversos materiales liquidos utilizamos un vaso de metal
con una capacidad de 106 ml, debido a que un vaso de metal
representaba la opcién mas segura en cuanto a la posible
expansion de materiales al cambiar de estado y ademas ser un
buen conductor térmico.
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En cuanto al ensamblaje del calorimetro en si, utilizamos los
siguientes materiales:

Arduino UNO (ATMega328P).
Sonda DS18B20.

Protoboard (opcional).
Resistor de 4.7 kQ.

6 Cables Dupont.

Ensamblar el calorimetro para que funcionara de maneraadecuada
no fue complicado, simplemente debiamos hacer que los cables
estuvieran en su lugar correspondiente. El cable rojo de la sonda
correspondia al cable del voltaje, el negro corresponde al cable
a tierra y el amarillo a convertir los datos de anélogo a digital
y enviarlos a la computadora. Ya que utilizar una protoboard a
pesar de ser opcional resultaba mas sencillo que soldar los cables
de manera inmediata, elaboramos el siguiente esquema a seguir:

Figura 1. Diagrama con protoboard (sin soldar)

Nota: Elaboracién propia.
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Figura 2. Diagrama sin protoboard (soldado directamente)

Nota: Elaboracién propia.

El cable Dupont correspondiente al cable amarillo no solo
conecta a la sonda, sino que también se encuentra detras del
resistor, el cual a su vez va conectado al cable rojo. En resumen,
el cable amarillo (datos) va conectado al pin 2 del Arduinoy ala
resistencia, el rojo (positivo) va conectado al pin 5V del Arduino
y a la resistencia, por ultimo, el negro (negativo) va conectado
directamente al pin GND del Arduino.

Entonces, con todo esto conectado de manera correcta, podemos
conectar el cable USB de la placa Arduino a la computadora
y ejecutar cualquier cédigo sin problemas utilizando el IDE de
Arduino el cual se puede descargar gratuitamente en la pagina
oficial de Arduino a través del siguiente link: https://www.arduino.
cc/en/software
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Figura 3. QR de la pagina de Arduino IDE

Nota: Elaboracién propia.

Dentro del IDE elaboramos un cédigo para que imprimiera el
tiempo junto a la temperatura el cual se puede observar en el
siguiente link: https://github.com/uv-Img/calorimetro

Ademas, dicho cédigo se puede modificar o utilizar gratuitamente
en GitHub:

Figura 4. QR de la pagina Github

u]

Nota: Elaboracién propia.

Una vez que todo estuvo preparado, procedimos con la
primera prueba. Utilizamos agua para demostrar su proceso
de enfriamiento dentro de un refrigerador y posteriormente su
calentamiento. Sin embargo, dado que una mayor cantidad de
aguarequiere una mayor cantidad de energia para su enfriamiento
y calentamiento, optamos por utilizar solo 40 ml de agua. Esta
cantidad fue medida con una probeta y luego verificada con una
bascula digital.

231



Al ejecutar el cédigo, este funciond correctamente, aunque
imprimia los datos de tal manera que sdélo se podian visualizar
dentro del propio IDE de Arduino. Esto esta bien, sin embargo, el
proceso de trasladar los datos manualmente a otro software para
su posterior analisis suele entorpecer el proceso.

Buscando una manera de guardar los datos, nos percatamos de
que estos se pueden encontrar de manera directa dentro del
siguiente puerto: /dev/ttyAMCO, por lo que se utilizd el comando
cat (en Linux) para escribir los datos directamente desde la consola
a un archivo (.txt) de manera constante, pero esto presenta varios
problemas; por ejemplo, los datos se guardaban cada segundo
lo que provocaba una repeticién innecesaria de datos, ademas,
con el propdsito de facilitar la recolecciéon de datos en Windows,
el cual no cuenta con dicha funcidn cat, decidimos buscar otra
alternativa.

Finalmente, se empledé un programa llamado «CoolTerm», un
freeware disefiado para gestionar puertos y redes, lo cual resulta
ideal en este caso ya que este software permite la transmisién
constante de resultados y su almacenamiento inmediato en un
archivo de texto.

Primero se selecciona el puerto en la parte inferior izquierda
del programa, que por defecto ya viene seleccionado «COM3
(Arduino Uno)» o algo bastante similar, en caso de no encontrarlo,
se puede regresar al propio IDE de Arduino el cual lo proporciona
en la parte superior de la interfaz o en la seccién «Tools >
Port» por lo que solo hace falta seleccionarlo manualmente
en CoolTerm. Después, para empezar a recibir los datos se da
clic en el cuarto botén, «Connect» (alternativamente se puede
presionar directamente CTRL+K) para conectarse y, por ultimo,
para empezar a registrar los datos en un archivo de texto (.txt) se
da clic en la pestafa «Connection > Capture to Text/Binary File >
Start...» o alternativamente presionando la combinacién de teclas
(CTRL+R) y al instante se inicia la captura de datos.
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Aunque una vez estando seguros de que el Arduino esta
correctamente conectado lo méas recomendable es primero
realizar la captura de datos “Connection > Capture to Text/
Binary File > Start...” y finalmente presionar «Connect», pero se
presentd al revés dado que es lo mejor para realizar pruebas de
conexion ya que al presionar «Connect» el programa CoolTerm
imprime al instante las lecturas de la sonda en pantalla y es facil
darse cuenta de que todo esta funcionando correctamente.

Asi pues, se determind que todo estaba listo y se colocé el agua
dentro del vaso y la sonda tocando el agua, evitando que tocase
el vaso con ayuda de cinta adhesiva puesto que determinamos
esto afectaria las mediciones, promediando las temperaturas
entre ambas superficies (del agua y del vaso) y asi obtuvimos
varias graficas, en dichas gréaficas observamos un fenémeno
curioso que ocurria casi siempre, un sobre-enfriamiento, lo cual
decidimos seguir analizando y dedicamos una parte mas adelante
en el capitulo. Sin embargo, al momento de llevar a cabo el
calentamiento, observamos que el hielo en algunos puntos se
descongelaba mas rapido que en otros, moviendo la sonda de
manera que los datos obtenidos se veian afectados, a veces
incluso de gran manera.

Como solucidn, se encontré un pedazo de espuma de polietileno
el cual luego de recortarlo a la medida encajaba de manera
perfecta en la boca del vaso, por lo cual fue suficiente hacer un
hoyo en el centro, del tamano de la sonda, para que se mantuviera
siempre firme contra cualquier alteracién de estado. Puesto que
el Arduino de manera automatica se ejecuta infinitamente una vez
se ha ejecutado en cualquier computadora, solo debiamos abrir
CoolTerm, conectar el puerto e indicarle que registre los datos,
de esta manera llevamos a cabo méas mediciones. Consideramos
ademas que no es necesario mantener la computadora prendida
una vez que los cambios esperados fueran medidos, por lo que
también se puede utilizar un comando en Windows (shutdown
-s —t) para que se apague automaticamente la computadora a
partir de una cierta cantidad de segundos, en este caso 36000
segundos o 10 horas.
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Observando nuevamente los resultados, nos dimos cuenta de que
con la tapa de espuma de polietileno el cambio de temperatura
se veia afectado y por ende no habia un sobre-enfriamiento, cosa
que queriamos estudiar, por lo que tuvimos que dejar de utilizarla.
Entonces, optamos por una opcién mas simple: meter la sonda,
de manera horizontal hasta el fondo del vaso. Gracias a esto, los
resultados volvieron a mostrar sobre-enfriamientos, probando
asi que la tapa afectaba al enfriamiento. Sin embargo, mantener
la sonda de esta manera también afectaba a los resultados del
calentamiento, ya que la sonda al tocar el vaso promedia las
temperaturas y al momento de que el hielo se descongelase
en varios puntos, hacia que los datos fluctuaran de una manera
extrafia, pero a pesar de todo esto y para fines practicos y de
estudio, los resultados son lo suficientemente satisfactorios.

Reto 1. Estudio de la “Ley de enfriamiento de Newton”

Haciendo una breve busqueda, es facil obtener informacién
de la cominmente llamada “Ley de enfriamiento de Newton”,
por ejemplo, la cual nos dice que “la tasa de pérdida de calor
de un cuerpo es proporcional a la diferencia de temperatura
entre el cuerpo y sus alrededores”. También nos menciona que
cuando la diferencia de temperatura entre el cuerpo (To) y su
medio ambiente (Tm) es pequefa, AT=To-Tm, el calor perdido es
proporcional a la diferencia de temperatura, AT. Isaac Newton
publicé anénimamente estos resultados en 1701 en la obra
«Scala graduum Caloris». Calorum Descriptiones & signa.» en
Philosophical Transactions.
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Figura 5. El enfriamiento de una taza de café

Enfriamineto de una taza de café
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Nota: Elaboracién propia.

Con los datos obtenidos se procedié a realizar una regresion
lineal para ajustar una curva que describa los datos medidos con
la cual obtuvimos la siguiente funcién exponencial

T(t)=(24.9330)e™0-0005t4 30 5759

La cual, después de graficarla en el mismo plano, podemos ver
que se ajusta perfectamente, demostrando que este calorimetro
digital cuenta con una excelente precisidn, a continuacién, se
muestra dicho gréfico.
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Temperatura

Figura 6. Ajuste exponencial a los datos del gréfico anterior

Enfriamiento de una taza de café
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Nota: Elaboracién propia.

Figura 7. Enfriamiento de un vaso con agua y hielo

Enfriamineto de agua con hielo
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Nota: Elaboracién propia.

236



De igual forma se puede notar cémo al poner un cubito de
hielo en un vaso de agua (150 ml) a temperatura ambiente, el
hielo comienza a enfriarla hasta que se derrite completamente,
posteriormente el ambiente mismo comienza a calentar de nuevo
el agua jpuedes adivinar hasta qué temperatura se calentaria?

Figura 8. Calentamiento de una plancha eléctrica

Calentamiento de una plancha
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Nota: Elaboracién propia.

Como se puede observar también al analizar el calentamiento de
una plancha de ropa se encuentra que su temperatura es variable
y existe un umbral tanto superior como inferior en el cual, al
llegar a una temperatura méaxima, se desconecta internamente
y una vez enfriada hasta el umbral inferior se conecta o activa
automaticamente y asi sucesivamente en ciclos.
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Figura 9. Congelamiento de un hielo dentro del refrigerador

Enfriamiento de 106 ml de agua
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Nota: Elaboracién propia.

Aqui podemos observar la disminucidn de la temperatura,
Podemos observar también que entra en la regién de liquido
sobre enfriado, periodo de congelamiento y enfriamiento del
solido (hielo). En esta actividad se recomienda.

Sobre-enfriamiento

Como mencionamos anteriormente, durante la elaboraciéon del
calorimetro, llegamos a observar varias veces un fenémeno
conocido como sobre-enfriamiento en el cual el agua que
metimos al refrigerador se enfriaba mucho mas alla del cero, pero
sin cambiar de estado, sin embargo, después de sufrir cualquier
pequefa alteraciéon regresaba a cero grados tal y como se
esperaba. Esto nos llamé la atencién asi que decidimos analizarlo
maés a fondo.

El sobre-enfriamiento se trata de un fenémeno en el cual un
material llega a una temperatura para la cual cuyo estado deberia
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cambiar, sin embargo, éste se mantiene. Usualmente después
de una excitacion las moléculas de dicho material terminan de
transformarse en el estado esperado.

Sabemos que en condiciones normales, el agua hierve a los
100 °C y se congela a los 0 °C, es algo que toda la vida nos
han ensefiado, pero cuando ocurre el fendmeno de sobre-
enfriamiento resulta que esto no se cumple, y ése simple hecho
resulta interesante, puesto que cuando hay sobre-enfriamiento
sucede que la temperatura baja mas alld de 0° C, digamos por
ejemplo a unos -5° C y sin embargo jEl agua sigue estando
liquida!l, cuando sabemos que debidé haberse congelado desde
que llegd a 0° C, es entonces cuando nos preguntamos, ;qué
estd sucediendo?, jen qué momento habra transicion de fase?,
pues en realidad no seré asi para siempre, ya que estamos frente
a lo que se conoce como un estado metaestable, el cual es un
estado de equilibrio pero muy susceptible a romperse, lo cual
como se mencioné anteriormente, quiere decir que cualquier
minima alteracidn en el sistema hard que colapse, en este caso el
colapso significa que el agua terminara congelandose y por ende
dando fin a este interesante fendmeno de sobre-enfriamiento.

Ademéas como se puede observar méas adelante en la gréafica (N.
de gréfica) es muy interesante ver que al momento de romperse
el estado metaestable y comenzar el proceso de solidificacion
del agua, la temperatura sube de -6° C a 0° C, esto quiere decir
que durante el proceso de formacién de cristales de hielo el
agua se esta calentado réapidamente 6 grados parallegara0°Cy
lograr la solidificacién, lo cual parece contra intuitivo, pues nadie
imaginaria que para congelar el agua se tendria que calentar,
pero no es mas que la muestra de que en este proceso se
libera energia en forma de calor, esta liberacién de energia esté
presente durante el tiempo que la temperatura se mantiene en
0° C durante la formacién de hielo, es decir, durante la transiciéon
de fase liquido a sélido, finalmente, una vez que el agua se ha
transformado en hielo, la temperatura continGia disminuyendo, ya
que ahora simplemente se continua enfriando el hielo.
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También es importante mencionar que el intervalo en el que la
temperatura pasa por debajo de uno de sus puntos de congelacion
y sigue de largo hasta antes de aumentar espontaneamente y
estabilizarse también se conoce como estado de sub-fusidn,
mientras que al ocurrir lo contrario, es decir, cuando el agua se
calienta por encima de su punto de ebullicién, pero sin hervir
(evaporarse) se conoce como sobre-calentamiento y es mucho
mas raro de observar que el sobre-enfriamiento. Ambos estados
son estados Unicos de los liquidos y pertenecen a su propia
categoria dentro de los diversos tipos de estados meta-estables
que se pueden encontrar.

En los resultados obtenidos no teniamos previsto observar un
sobre-enfriamiento, pero después de observarlo concluimos
que tenia sentido puesto que cuando existe un exceso de
refrigeracién, es mucho mas probable esperar observar un sobre-
enfriamiento debido a que el sistema sufriendo el cambio de
temperatura busca siempre mantener una presion equilibrada,
al mantener un enfriamiento efectivo y constante sobre dicho
sistema, las probabilidades de observar un sobre-enfriamiento
aumentan exponencialmente, de la misma manera la humedad
juega un papel relevante en este fenémeno.

Es por esto que ademas, creemos que fue lo que provocé que no
se observara un sobre-enfriamiento cuando el vaso tenia la tapa
de espuma de polietileno colocada, ya que al tenerla colocada, el
sistema era mas equilibrado tanto en presién como en humedad
y el enfriamiento seria mas directamente por medio del propio
recipiente y la tapa que por el ambiente en si, la distribucién
desigual de la temperatura llevaria a que algunas partes se
calentaran o enfriaran mas o menos que otras, alterando al
sistema lo suficiente como para no sobre-enfriarse.
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Reflexion final

Hemos descrito el proceso de creacién de un calorimetro digital,
el cual cuenta con muchos beneficios y posibles utilidades
y ofrecemos diagramas, fotos y el cddigo utilizado para su
elaboracion. De la misma manera, compartimos un interesante
descubrimiento a partir del uso del calorimetro elaborado, el cual
corresponde al sobre-enfriamiento.

En comparaciéon con otras herramientas tradicionales de
laboratorio creemos que este dispositivo resulta mas econdémico,
versatil y confiable, siendo ideal para la divulgacién, asi como
para la ensefanza a diversos estudiantes ya sea compartiendo los
resultados obtenidos o ayudandolos a elaborar un calorimetro
por su cuenta.

El costo total del sistema completo es inferior a $500.00 pesos.
Por lo que ademas de ser una herramienta Gtil para la ensefanza
de conceptos de termodinamica, este dispositivo es una excelente
forma de introducir a los estudiantes en conceptos bésicos de
microelectrénica.
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